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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

PICDEM™ FS USB Demonstration Board. Items discussed in this chapter include:

� Document Layout

� Conventions Used in this Guide

� Warranty Registration

� Recommended Reading

� The Microchip Web Site

� Development Systems Customer Change Notification Service

� Customer Support

� Document Revision History

DOCUMENT LAYOUT

This document describes how to use the PICDEM™ FS USB Demonstration Board as 

a development tool to emulate and debug firmware on a target board, as well as how 

to program devices. The document is organized as follows:

� Chapter 1. “Introduction to the PICDEM™ FS USB Board” describes the hard-

ware of the demonstration board, and how it can be used in creating new USB 

solutions.

� Chapter 2. “Preprogrammed Firmware – DM163025-1” describes how to con-

nect the demonstration board to a host system, and how to install the Demonstra-

tion Tool software.

� Chapter 3. “Getting Started with the PICDEM™ FS USB Board – DM163025” 

describes how to use the application in both Demo and Bootload modes.

� Chapter 4. “Using the Demo Tool Application – DM163025” refers to the 

“MCHPFSUSB Firmware User’s Guide” (DS51679), which describes how to 

design USB solutions using the reference firmware.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB IDE online help. 

Select the Help menu, and then Topics to open a list of available online help files.
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� Chapter 5. “Using the Microchip USB Firmware Framework” – The board’s 

preloaded demonstrations, and other demonstrations and projects available in the 

MCHPFSUSB Framework

� Chapter 6. “Reconfiguring the PICDEM™ FS USB Hardware” describes how 

to tailor the demonstration board’s hardware to your application.

�  Chapter 7. “Troubleshooting” discusses some common questions about using 

the demonstration board.

� Appendix A. “PICDEM™ FS USB Board Technical Information” provides the 

schematics and other technical details about the demonstration board.

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 

[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Send-

ing in the Warranty Registration Card entitles users to receive new product updates. 

Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the PICDEM™ FS USB Demonstration Board. 

Other useful documents are listed below. The following Microchip documents are 

available and recommended as supplemental reference resources.

Microchip Library for Applications (MLA) Release Notes

The MLA release notes contain up-to-date information regarding specific release 

versions of the MLA USB framework.

MCHPFSUSB Firmware User’s Guide (DS51679)

The “MCHPFSUSB Firmware User’s Guide” includes important information useful in 

understanding how the reference USB firmware works. This framework can be found 

on the Microchip USB design center: http://www.microchip.com/usb.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in 

the Readmes subdirectory of the MPLAB® IDE installation directory. The Readme files 

contain update information and known issues that may not be included in this user’s 

guide.

PIC18(L)F2X/45K50 Device Data Sheet (DS30684)/PIC18F2445/2550/4445/4550 

Device Data Sheet (DS39632)

This is the comprehensive reference for Microchip’s enhanced microcontroller with 

full-speed USB. For users already familiar with the USB protocol, the data sheet 

provides the basic information needed for designing the hardware and firmware for a 

Microchip-based USB solution.

USB Specification, Revision 2.0 (USB Implementers Forum, Inc., www.usb.org)

For developers creating a USB application from the ground up, this is the 

comprehensive reference on the Universal Serial Bus protocol. All features of USB, 

from physical and electrical specifications to data and communication protocols to 

device management are defined here. Chapters 5, 8 and 9 are especially useful for 

those interested in understanding and developing USB peripheral devices.

TROUBLESHOOTING

See Chapter 7. “Troubleshooting” for information on common problems.
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB® C compilers; all MPLAB 

assemblers (including MPASM™ assembler); all MPLAB linkers (including 

MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 

librarian).

� Emulators – The latest information on Microchip in-circuit emulators.This 

includes the MPLAB® REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

� In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 

debug express.

� MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows Inte-

grated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 

MPLAB SIM simulator, as well as general editing and debugging features.

� Programmers – The latest information on Microchip programmers. These include 

production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 

ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 

are nonproduction development programmers such as PICSTART® Plus and 

PICkit 2 and 3.
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. 

Technical support is available through the web site at: 

http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision C (March 2013)

� Updated document to describe new board variant DM163025-1.
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PICDEM™ FS USB USER’S GUIDE

Chapter 1.  Introduction to the PICDEM™ FS USB Board

1.1 INTRODUCTION

The PICDEM™ FS USB Demonstration Kit is designed as an easy-to-use evaluation 

and development platform for the PIC18F45K50, PIC18F4550 and similar families of 

PIC18 USB 2.0 full-speed microcontrollers.

Two board variants exist. The original PICDEM FS USB Demo board (DM163025) 

comes populated with the PIC18F4550 microcontroller, while the newer version of the 

PICDEM FS USB Demo board (DM163025-1) comes populated with the PIC18F45K50 

device.

The Demonstration Kit provides all of the hardware and software needed to 

demonstrate and develop a complete USB communication solution. Items discussed in 

this chapter include:

� PICDEM FS USB Demonstration Kit Contents

� Overview of the PICDEM FS USB Board

� PICDEM FS USB Board Features

� Demonstration Tool Software

1.2 PICDEM FS USB DEMONSTRATION KIT CONTENTS

The Demonstration Kit contains the following items:

1. The PICDEM FS USB demonstration board, preprogrammed with USB 

bootloader and demonstration firmware.

2. A standard USB cable for use in communicating with the board.

3. The PICDEM FS USB Starter Kit CD-ROM, containing the USB driver, Demo 

Tool application and development tools (only included with DM163025).

1.3 OVERVIEW OF THE PICDEM FS USB DEMONSTRATION BOARD

The microcontroller for the PICDEM FS USB board DM163025-1 is the PIC18F45K50, 

the superset (largest memory and pin count) device of the PIC18(L)F2X/45K50 family. 

The microcontroller for the PICDEM FS USB board DM163025 is the PIC18F4550, the 

superset (largest memory and pin count) device of the PIC18F2455/2550/4455/4550 

family. All of these devices implement power-saving nanoWatt Technology, Enhanced 

Flash program memory, and feature USB modules with the following:

� USB 2.0 compliance

� Full-speed (12 Mbit/s) and low-speed (1.5 Mbit/s) operation

� Support of control, interrupt, bulk and isochronous transfers

� Support of up to 32 endpoints

� 1 Kbyte of dual access RAM for USB

� On-chip features for a true single chip USB implementation, including

- USB transceiver

- USB voltage regulator

- USB pull-up resistors
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The PICDEM FS USB Demo Board is intended to be used in conjunction with the 

MCHPFSUSB Framework, which is a library of USB example projects, source code, 

PC applications, tools, documentation, and other resources necessary for developing 

complete USB communication systems. In order to begin using the demo board 

hardware and the out-of-box example firmware, it will be necessary to download the 

MCHPFUSB Framework, as it includes the example PC software and drivers needed 

to interface with the demo firmware. The MCHPFSUSB Framework is currently 

distributed as part of the Microchip Libraries for Applications (MLA), which is 

downloadable from www.microchip.com/mla. 

The board comes preprogrammed with a default demo application and is ready for 

evaluation right out of the box. New programs can be downloaded to the 

microcontroller using a preprogrammed bootloader via the USB interface. A PC-based 

application, the PICDEM FS USB Demo Tool, facilitates the bootloading process and 

serves as the host application in the default demonstration.

1.3.1 Benefits of Using the PICDEM FS USB Board

The PICDEM FS USB demonstration board provides two simple advantages: 

A READY-TO-USE DEMONSTRATION: As delivered, the board is ready for full-speed 

USB operation; all that is required is the proper driver (included) and the Demo Tool 

application. Users can also reprogram the board with different applications, included on 

the Starter Kit CD, to evaluate other USB solutions that can be tailored to their needs.

AN EXPANDABLE PLATFORM: Users can also expand the hardware capabilities of 

the board through its expansion headers, and even interface it with available PICtail™ 

demonstration and evaluation daughter boards.

1.4 PICDEM FS USB BOARD HARDWARE FEATURES

The overall layout of the board is shown in Figure 1-1, with a list of the main features 

following. The more complex features are discussed in detail later in this section.

FIGURE 1-1: THE PICDEM™ FS USB BOARD (TOP ASSEMBLY VIEW)
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1. Microcontroller: The 44-pin TQFP PIC18F45K50 microcontroller (U2) or 44-pin 

TQFP PIC18F4550 (U2) is the heart of the demonstration board, and provides 

all USB functionality on one chip. Refer to the respective device data sheet 

(DS30684 or DS39632, respectively) for a complete discussion of the 

microcontroller and its feature set. 

2. ICE Interface Riser: The microcontroller is surrounded by a 44-pin pad (U5), 

arranged as four groups of 11 on each side. These locations can be used to mount 

a riser for interfacing with Microchip’s MPLAB ICE 2000/4000 emulator system.

3. Oscillator (only on DM163025): The demonstration board uses a 20 MHz 

crystal oscillator (Y1) as the primary clock service. The PIC18F4550 uses this 

oscillator to generate the necessary clock signals for both the USB Serial 

Interface Engine (SIE) and the core processor. The oscillator is not populated on 

the DC163025-1 revision due to the PIC18F45K50 uses the Active Clock Tuning 

(ACT) circuit to tune the internal oscillator to be within USB specification. For 

more information about ACT refer to the PIC18F45K50 data sheet (DS30684).

4. ICD Configuration Jumpers: These three unpopulated jumper positions allow 

the user to choose either legacy or dedicated ICSP™ and ICD ports for the 

controller. By default, the board is hard-configured for the legacy port. The 

configuration and use of these jumpers is detailed in Section 6.2 “Configuring 

the Demonstration Board Options”.

5. Expansion and PICtail Daughter Board Headers: The pads at J6 and J7 are 

provided for users to install the header and directly access the microcontroller’s 

I/O port signals. In addition, the 14 even numbered pins of J6 (those on the right 

side as viewed from the top) serve as the interface for Microchip’s PICtail 

daughter boards. This allows the PICDEM FS USB board to be used as a test 

platform and USB communications interface for the PICtail daughter boards.

6. Configuration Jumpers: A total of 13 unpopulated jumper positions are 

provided across the board; these allow users to modify the board by configuring 

its hardware to suit their needs. By default, all jumpers are bridged and all 

features are enabled. The configuration and use of these jumpers is detailed in 

Section 6.2 “Configuring the Demonstration Board Options”.

7. Potentiometer: The potentiometer (R20) simulates an analog input for the 

controller. Its real-time value can also displayed by the Demo Tool host software.

8. Temperature Sensor: A Microchip TC77 digital temperature sensor (U4) 

continuously monitors the board’s ambient temperature. Data is transmitted to 

the controller via a 3-wire SPI interface, and is displayed in real time by the Demo 

Tool software.

9. Power LEDs (Green): These LEDs light to show that power is being supplied to 

the board, and to indicate how the board is being powered. LED D7 indicates that 

the board is being powered from the bus, while LED D8 indicates the board is 

being powered from a separate power supply.

10. Reset Push Button: This switch (S1) is tied to the MCLR pin of the 

microcontroller; pressing it causes a hard device Reset.

11. Power Connector: Power (9 VDC) can be supplied to the board from an external 

power adapter through a mini barrel jack. Using an external supply is optional, 

as all examples provided with the demonstration board can use power from the 

USB cable. 

12. USB Connector: This is a standard USB type “B” receptacle. The USB port is 

the primary channel for controlling and communicating with the demonstration 

board.

13. ICD Connector: This 6-wire RJ11 connector provides the standard interface 

used by Microchip development and demonstration boards for programming and 

debugging applications, using MPLAB ICD 3 and other development tools. 
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14. Status LED Bank: A bank of four green LEDs are used to show the operational 

status of the board. Two LEDs (D1 and D2) are used by the application firmware 

to indicate the status of the USB connection. The other LEDs (D3 and D4) can be 

defined by the user; they are directly controllable through the Demo Tool software.

15. User-Defined Push Buttons: These two switches (S2 and S3) are provided to 

simulate digital control inputs. Pressing either button causes its port to read 

as ‘0’.

16. RS-232 (DB9F) Port: A standard D-shell connector, along with a standard level 

shifter (U1), provides an RS-232 serial connection to the demonstration board.

1.4.1 Oscillator and Operating Frequency

The USB module of the installed PIC18F45K50 requires a specific clock frequency 

input to operate correctly; specifically, 48 MHz is required when operating in Full-Speed 

mode, or 6 MHz when operating in Low-Speed mode. 

On DM163025-1, the PIC18F45K50 uses its own internal FRC (Fast RC) oscillator 

running at 16 MHz along with a 3X PLL to achieve the required 48 MHz, using the 

Active Clock Tuning feature to keep the USB frequency within 0.25% of its correct 

value. A detailed explanation of how to set up the clock configuration is explained in 

Chapter 3 of the PIC18F45K50 device data sheet (DS30648).

On DM163025, the PICDEM FS USB board uses a 20 MHz crystal oscillator as an 

external clock, and derives the necessary internal clock frequencies from the 96 MHz 

PLL module. The clock configuration used on the demonstration board is shown in 

Figure 1-2. A detailed explanation of how to set up the clock configuration is explained 

in Chapter 2 of the PIC18F4550 device data sheet (DS39632). 

The PICDEM FS USB board is configured to run in Full-Speed USB mode, generating 

an internal system clock of 48 MHz (equivalent to 12 MIPS) from the external 20 MHz 

crystal or the internal RC oscillator if clock tuning is available on the microcontroller.

FIGURE 1-2: PIC18F4550 CLOCK SETUP FOR PICDEM™ FS USB 
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FIGURE 1-3: PIC18F45K50 CLOCK SETUP FOR PICDEM™ FS USB

1.4.2 Power

The PICDEM FS USB demonstration board operates at 5V. Power can be drawn 

directly from the USB bus or from an external power supply. There are no jumpers to 

select which power source to use. Instead, the power circuitry automatically selects the 

external power source when both power sources are available. Two LEDs, D7 and D8, 

are typically used by the example firmware projects in the MLA to indicate current USB 

bus operating state.

Like most USB peripherals, the PICDEM FS USB board can be powered from the 5V 

available from the USB cable. A minimum of 100 mA is always available on the bus for 

a device; a maximum of 500 mA can be requested and used if available.

A barrel-type power supply connector (2.5 mm diameter) is also provided to run the 

board from a 9-18 VDC power supply. A transformer is not supplied in the kit because 

all the examples included will run from USB bus power.

A USB host may send a query to a USB device to determine if it is currently 

self-powered. Without an ability to sense the output of the 5V regulator (VR1), there 

would be no way to determine the status of the power supply. The PICDEM FS USB 

board uses two of the microcontroller’s I/O pins (PORTA<2:1>) to sense which supply 

is available: PORTA<2> monitors the regulator, while PORTA<1> senses the USB 

cable. When a port is read as ‘1’, its corresponding power source is active. When a port 

is read as ‘0’, its source is disconnected. The combinations of PORTA states are shown 

in Table 1-1.

For more details on power requirement and management, refer to Microchip 

application note AN950, “Power Management for PIC18 USB Microcontrollers with 

nanoWatt Technology” (DS00950).

(configured for
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Divide-by-2

Configurable
Clock Postscaler

(configured as
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96 MHz 48 MHz

48 MHz

CPU and

Clock

USB
Clock

PIC18F4550 Oscillator Block

Peripherals
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Internal
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TABLE 1-1: PORTA<2:1> STATE COMBINATIONS AND THEIR MEANINGS

1.4.3 USB Interface

The PICDEM FS USB board utilizes the on-chip USB voltage regulator, transceivers 

and pull-up resistors of the PIC18F45K50 or PIC18F4550. This helps reduce the 

number of external components. The USB connection can be electrically detached by 

disabling the USB module in the firmware. By disabling the USB module in firmware 

(setting the USBEN bit in the UCON register to ‘0’), the on-chip USB voltage regulator 

will also be disabled. This simulates the physical detachment of the USB cable.

Figure 1-4 shows the electrical connection for the USB interface on the board.

FIGURE 1-4: USB INTERFACE, SHOWING ON-CHIP COMPONENTS

1.4.4 RS-232 Interface

The PICDEM FS USB board fully supports RS-232 serial communications, including 

hardware flow control (RTS/CTS signalling) generated by pins RA2 and RA3 of the 

microcontroller. One RS-232 female connector and all supporting circuitry are included. 

1.4.5 Status LEDs

There are four firmware-controllable LEDs, D1 through D4. An LED is turned on when 

the corresponding port bit has the value of ‘1’, and off when the port bit is ‘0’. 

The PICDEM FS USB demo board comes preprogrammed with firmware which uses 

the LEDs to indicate the current USB device state, or to show application 

communication status (for example: while interfacing with a host PC program).

PORTA<1> PORTA<2> Status

1 1 USB cable and power supply are both connected; board is 

self-powered, D8 is lit

1 0 USB cable is attached; board is bus-powered, D7 is lit

0 1 Power supply only is attached; board is self-powered, D8 is 

lit 

0 0 N/A

RC4/D-

RC5/D+

VUSB

USB
Transceiver

USB 3.3V
Voltage 

1

2

3

4

VBUS (5V)
PIC18F4550 (partial)

1.5 k

470 nF

USB Connector

Regulator(3.3V)

1.5 k
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1.5 DEMO TOOL APPLICATION SOFTWARE

Included with the demonstration board is the USB Demo Tool software. This simple 

graphic interface allows users to monitor and control simple board features, and 

provides the ability to reprogram the PIC18F45K50/PIC18F4550 controller via a 

bootloader demonstration.

The overall operation of the host software, when interfacing with DM163025-based, 

out-of-box demo firmware, is discussed in Chapter 4. “Using the Demo Tool 

Application – DM163025”. For the DM163025-1 board, please see Chapter 

2. “Preprogrammed Firmware – DM163025-1”.
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NOTES:
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Chapter 2.  Preprogrammed Firmware – DM163025-1

2.1 OVERVIEW

Microchip provides a wide variety of USB related example firmware projects, PC 

application projects, drivers, and other related resources for developing complete USB 

peripheral and host devices. These resources are included in the MCHPFSUSB 

Framework distribution package.

The free package can be downloaded from the Microchip USB Design Center: 

http://www.microchip.com/usb

Many of the USB device demonstrations and projects in the MCHPFSUSB Framework 

are specifically intended for the PIC18F45K50, so they require no hardware or other 

modifications.

Example USB firmware is preprogrammed on the PIC18F45K50. The microcontroller 

contains both demo firmware and a USB bootloader that is independent of the demo 

firmware. The bootloader can be used to program a new application’s firmware *.hex 

files into the microcontroller’s Flash memory, eliminating the need for a dedicated 

In-Circuit Serial Programming™ (ICSP™) programmer.

To enter the Bootloader mode, hold down the S2 push button and momentarily press 

and release the MCLR S1 push button. The microcontroller firmware checks the RB2 

I/O pin state one time after coming out of Reset. (For more information on the USB 

bootloader, see Section 2.3 “Using the HID Bootloader Firmware”.)

The microcontroller firmware will enter the demo mode if the RB2 push button is not 

pressed during power-up or Reset. If the microcontroller is not in the Bootloader mode, 

it is in Demo mode. (For more information on the composite HID+MSD demo firmware, 

see Section 2.2 “Using the Composite HID+MSD Class Demo Firmware”.)

When a Demo mode device is plugged into a host PC, the device should automatically 

enumerate as a USB “composite” HID (Human Interface Device) and MSD (Mass 

Storage Device). Common operating systems (including Windows®, Mac OS® and 

Linux®) ship with built-in HID and MSD class USB drivers. Additional drivers should not 

be needed to use the default demo firmware programmed on the PIC18F45K50 

microcontroller.

With successful enumeration in Demo mode, under the Windows operating system, 

additional entries should appear in the Windows Device Manager dialog box. 

Figure 2-1 shows how the dialog box appears in the Windows XP® operating system 

with arrows indicating the new entries listed for the board. (The dialog box’s 

appearance may vary in other versions of the Windows operating systems, such as 

Windows Vista®, Windows 7 or Windows 8.)

Note: This chapter is specific to the PICDEM™ FS USB Demo Board 

DM163025-1, when it is populated with the PIC18F45K50 microcontroller. 

For the DM163025 version PICDEM FS USB demo boards populated with 

the PIC18F4550, please refer to Chapter 4. “Using the Demo Tool 

Application – DM163025” instead.
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FIGURE 2-1: WINDOWS® XP DEVICE MANAGER ENTRIES (DEMO MODE)

Note: Lines indicate the new entries that appear because the device has 

been attached to the PC.
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2.2 USING THE COMPOSITE HID+MSD CLASS DEMO FIRMWARE

2.2.1 MSD Interface

The MSD (Mass Storage Device) interface displays the PIC18F45K50 in My Computer 

as a new drive volume, similar to a USB “thumb drive” Flash memory device. Upon suc-

cessful enumeration in Demo mode, the new drive volume will display Readme.txt, 

a writable text file stored in the microcontroller’s Flash memory.

For additional information, read the text file.

2.2.2 HID Interface

The HID (Human Interface Device) interface enables generic USB data transfer to and 

from an attached device. Although the HID class is normally used for interface 

products, such as keyboards and mice, the HID interface alternatively can be used for 

other data transfer purposes.

The HID interface on the PIC18F45K50’s default firmware is meant to be used with the 

PC application project, HID PnP Demo Composite HID+MSD Demo only 

(PID=0x0054).exe, provided in the USB section of the Microchip Library for Appli-

cations. The latest version of the package is also available from the Microchip USB 

Design Center: www.microchip.com/usb.

If the MCHPFSUSB Framework Version 2.4 is installed in the default directory, the HID 

PnP Demo Composite HID+MSD Demo only (PID=0x0054).exe executable file 

is in the directory:

C:\Microchip Solutions(date of release)\USB\Device - 

Composite - HID + MSD

The demo PC application is intended to be run under Windows and was written in 

Microsoft® Visual C++® 2005 Express Edition. If the executable fails to launch correctly, 

review the PC’s control panel – add or remove the programs list to ensure that the .NET 

Framework Version 2.0 (or later) redistributable package has been installed.

The .NET redistributable package can be downloaded from Microsoft®.

If the USB device has been plugged in and has successfully enumerated, the device 

should be detected automatically by the demo PC application. Figure 2-2 gives an 

example of how the PC application appears in Windows XP.

FIGURE 2-2: HID DEMO APPLICATION

The demo PC application provides a simple graphical user interface for sending and 

receiving small amounts of example data to and from the HID interface on the USB 

device. Full source code for both this PC application and the demo firmware are 
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included in the MCHPFSUSB Framework. Assuming the MCHPFSUSB Framework 

has been installed in the default location, the source code for both the firmware and PC 

application are found in the following directory:

C:\Microchip Solutions(date of release)\USB\Device - Composite - 

HID + MSD

The demo PC application can be used to toggle the LEDs on the demo board, 

determine the RB2 push button state and measure the analog voltage on the micro-

controller’s RA0 I/O pin. The analog voltage on RA0 is measured by the ADC of the 

microcontroller and graphically displayed by the “ANx/POT Voltage” bar, as shown in 

Figure 2-2.

2.3 USING THE HID BOOTLOADER FIRMWARE

The PIC18F45K50 is preprogrammed with HID class USB bootloader firmware as well 

as the USB composite HID+MSD demo firmware. The HID bootloader is independent of 

the composite HID+MSD demo firmware.

The bootloader firmware can be used to update the Flash memory contents of the 

PIC18F45K50 microcontroller, similar to using a dedicated, ICSP™ based program-

mer. When the bootloader is used, a new .hex file can be programmed into the device 

by sending it directly over the USB cable to the PIC18F45K50.

The HID bootloader firmware uses self-programming operations to update the Flash 

memory contents of the microcontroller.

To use the HID bootloader:

1. Launch the HID bootloader application.

A link to this program can be found in the C:\Microchip Solutions(date of 

release)\USB\Device - Bootloaders\HID folder. The dialog box, shown in 

Figure 2-3, appears. (This dialog box appears whenever the USB device is not 

yet attached or the firmware is not in Bootloader mode.)

FIGURE 2-3: USB HID BOOTLOADER APPLICATION – NO DEVICE
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2. Plug the PIC18F45K50 into a free USB port.

3. Place the board in the Bootloader mode by pressing and holding down the S2 

push button (RB2 I/O pin). While still holding down the S2 push button, momen-

tarily press and release the MCLR push button (S1) to reset the device, keeping 

the S2 button depressed until after the device has come out of Reset.

The bootloader firmware performs a quick check of the RB2 I/O pin after coming 

out of Reset to determine if the device should enter Bootloader or normal Demo 

mode.

As a result:

� The device re-enumerates as a generic HID class device (instead of a composite 

HID+MSD device)

� The “USB HID Bootloader” PC application automatically detects the 

PIC18F45K50

� The dialog box, shown in Figure 2-4, appears

FIGURE 2-4: USB HID BOOTLOADER APPLICATION – DEVICE FOUND

Once the PC application has found the USB device, the application can be used to 

open the Intel® HEX 32-bit formatted *.hex firmware images and program them using 

the respective buttons.

MPLAB IDE can be used to create these firmware image files by:

1. Building a firmware project and using a modified linker script necessary for the 

bootloader.

2. Selecting File>Export and specifying the file format, INHX32.

By default, the precompiled demo .hex files included in the MCHPFSUSB Framework 

distribution can be programmed using the USB bootloader application. The demo’s 

firmware projects were created using the appropriately modified linker script, so the 

demos should work directly with the bootloader.
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Programming a new firmware image using the bootloader does not erase or overwrite 

the bootloader firmware inside the microcontroller. To execute newly programmed firm-

ware with the bootloader application, reset the microcontroller by pressing the MCLR 

(S1) push button.
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Chapter 3.  Getting Started with the PICDEM™ FS USB 
Board – DM163025

3.1 HIGHLIGHTS

This chapter will cover the following topics:

� Host Computer Requirements

� Installing the Demonstration Board

3.2 HOST COMPUTER REQUIREMENTS

The USB module included on the PIC18F4550 family of microcontrollers is not specific 

to Windows operating system-based USB platforms. The module may be used to 

develop USB-based applications intended to interface with Windows operating system, 

Linux, Macintosh® computers or other types of USB capable host systems. However, 

the demonstration firmware preprogrammed on the PICDEM FS USB Demo Board is 

intended to interface with the PICDEM FS USB Demo Tool, which is a Windows oper-

ating system-based application. In order to use the preprogrammed demonstration 

firmware and software, the following hardware and software requirements must be met:

� PC-compatible system 

� An available USB port

� CD-ROM drive (for use with the accompanying CD)

� Windows operating system, see supported Windows version in the MCHPFSUSB 

Release Notes.

3.3 INSTALLING THE DEMONSTRATION BOARD

As a USB device, the demonstration board requires very little effort to install; most of 

the work is done by the operating system. The three steps required are:

1. Installing the MCHPFSUSB software package

2. Connecting the PICDEM FS USB board

3. Installing the USB driver

Note: This chapter is specific to the PICDEM™ FS USB Demo Board DM163025, 

when it is populated with the PIC18F4550 microcontroller. For newer 

version PICDEM FS USB demo boards, populated with the PIC18F45K50, 

please refer to Chapter 2. “Preprogrammed Firmware – DM163025-1” 

instead.
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